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Revision History

Revision Date Description
1.0 2010-10-01 | Initial release
1.1 2010-12-13 | Added ‘scl’ and ‘gcl’ command
1.2 2010-12-21 | Added VC-2MC-M/C340 model
1.3 2011-04-07 | Revised Max. Frame Rate
1.4 2011-07-12 | Added 2 Tap and 4 Tap 10 bit
* Added VC-2MC-150 and VC-4MC-80
¢ Added Camera Block Diagram description
1.5 2011-10-25 |« Added Data Format
* Added Defective Pixel Correction
e Added Appendix Aand B
1.6 2011-11-11 | Added VC-4MC-40
1.7 2012-06-19 | Added 8 Tap 10 bit data output to VC-2MC-340 and VC-4MC-180 models
1.8 2012-08-27 | Revised the description of the Get Trigger Mode command
e Changed the User Manual file name
19 2012-1015 e Deleted VC-4MC-40 model
*  Added VC-3MC-280 model
*  Added VC-25MC-30 model
20 2013.06.14 e Added description of M5 set screws for tilt adjustment
*  Added Actual Time Applied for Commands
2.1 2013-09-09 |+ Added VC-12MC-65
05 20131111 * Added 2 Tap and 4 Tap output mode to VC-12MC-65
* Revised the maximum FPS values depending on ROI Size of VC-2MC
2.3 2014-07-25 | Added the maximum FPS values depending on ROI Size of VC-4MC
24 2014-09-19 | Applied new CI
25 2015-04-30 | Added the Flat Field Correction feature to VC-25MC-30
06 2015.06.19 Added the Flat Field Correction and HDR features to VC-2MC-340 and
VC-4MC-180
2.7 2015-09-07 | Changed the VC-25MC’s mechanical dimension
2.8 2016-04-22 | Added typical power requirements
e Added the Multi-ROI feature (VC-25MC)
29 2016-06-17 | = Added the Strobe Delay feature (VC-25MC)
e Added the AWB feature (VC-25MC)
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Revision Date Description
3.0 2017-03-24 | Added the VC-25MC2-30 (PYTHON-25K)
3.1 2018-01-19 | Added the Flat Field Selector feature to VC-12MC-65
Added a note indicating the Strobe Offset (Strobe Delay) feature is only
3.2 2018-07-20
available on VC-25MC/VC-25MC2.
3.3 2018-10-31 | Changed the model name (VC-25MC2-M/C 30 = VC-25MC-M/C 30 D)
Revised the frame rate and added features (Sequencer and FFC storage) to
3.4 2019-04-05
VC-25MC-M/C 30 D
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1 Precautions

General

CAUTION

Do not drop, disassemble, repair or alter the device. Doing so may damage the camera
electronics and cause an electric shock.

Do not let children touch the device without supervision.

Stop using the device and contact the nearest dealer or manufacturer for technical
assistance if liquid such as water, drinks or chemicals gets into the device.

Do not touch the device with wet hands. Doing so may cause an electric shock.

Make sure that the temperature of the camera does not exceed the temperature range

specified in 5.2 Specifications. Otherwise the device may be damaged by extreme

temperatures.

Installation & Maintenance

CAUTION

Do not install in dusty or dirty areas - or near an air conditioner or heater to reduce the risk
of damage to the device.

Avoid installing and operating in an extreme environment where vibration, heat, humidity,
dust, strong magnetic fields, explosive/corrosive mists or gases are present.

Do not apply excessive vibration and shock to the device. This may damage the device.
Avoid direct exposure to a high intensity light source. This may damage the image sensor.
Do not install the device under unstable lighting conditions. Severe lighting change will
affect the quality of the image produced by the device.

Do not use solvents or thinners to clean the surface of the device. This can damage the

surface finish.

Power Supply

CAUTION

Applying incorrect power can damage the camera. If the voltage applied to the camera is
greater or less than the camera’s nominal voltage, the camera may be damaged or operate

erratically. Please refer to 5.2 Specifications for the camera’s nominal voltage.

X Vieworks Co., Ltd. does NOT provide power supplies with the devices.
Make sure the power is turned off before connecting the power cord to the camera.

Otherwise, damage to the camera may result.
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2 Warranty

For information about the warranty, please contact your local dealer or factory representative.

3 Compliance & Certifications

3.1 FCC Compliance

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference
when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate
radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause
harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause

harmful interference in which case the user will be required to correct the interference at own expenses.

3.2 CE: DoC

EMC Directive 2014/30/EU
EN 55032:2012 (Class A), EN 55024:2010
Class A

3.3 KC

KCC Statement

Description
Class A This device obtained EMC registration for office use (Class A), and may be
(Broadcasting Communication used in places other than home. Sellers and/or users need to take note of
Device for Office Use) this.
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4 Package Components

Package Components

/',
N\

——

/

’

M /)

VC Camera <C-mount> VC Camera <F-mount>

Mount Plate (Optional)

p3

M5 Set Screws for Tilt Adjustment (Provided only with F-mount camera)

*  You can adjust the tilt using the M5 set screws, however it is not recommended since it is
adjusted as factory default settings.
* If the tilt settings need to be adjusted inevitably, please contact your local dealer or factory

CAUTION
representative for technical support.
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5 Product Specifications

5.1 Overview

VC Series is a high speed industrial area scan camera equipped with the latest global shutter CMOS image

sensor. With its high reliability and durability, this camera is best suitable for machine vision requiring high-speed

continuous shooting.

Main features

High speed 2/3/4/12/25 megapixel CMOS image sensor
Electronic exposure time control (global shutter)

Output Pixel Format

= VC-2MC/4MC/12MC/25MC: 8/ 10 bit

= VC-3MC: 8 bit

Strobe Output

Defective Pixel Correction

Camera Link Output Mode

= VC-2MC /4MC / 12MC: 2 Tap, 4 Tap, 8 Tap, 10 Tap
= VC-3MC /25MC: 8 Tap, 10 Tap

Gain/Offset Control

Test Image

LVDS (RS-644) serial communication by Camera Link interface
Temperature monitor

Field upgrade

Dark image correction (Supported only on VC-2MC / 3MC / 4MC / 12MC)

Flat Field Correction (VC-2MC-340 / VC-4MC-180 / VC-12MC-65 / VC-25MC-30 / VC-25MC-30 D Only)

HDR (High Dynamic Range - VC-2MC-340 / VC-4MC-180 Only)
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5.2 Specifications

Specifications for each VC camera model are as follows.

VC Series

Resolution (H x V)

VC-2MC-150 VC-2MC-340 VC-3MC-280

2048 x 1088 1696 x 1710

Sensor CMOSIS CMV 2000 On Semiconductor LUPA 3000
. 13.57 mm x 13.68 mm
Sensor Size 11.26 5.98 Optical F t: 2/3"
- mn (Optical Forma ) (Optical Format: 1")
Sensor Type High Speed Progressive Scan CMOS Image Sensor
Pixel size 55 um x 55 um 8.0 uym x 8.0 um
Interface Camera Link

Electronic Shutter

Global Shutter

Max. Frame Rate

2 Tap: 74.4 fps 2 Tap: N/A

4 Tap: 148.5 fps 4 Tap: N/A

Transfer Time

8 Tap: N/A 8 Tap: 295.4 fps 8 Tap: 227 fps
10 Tap: N/A 10 Tap: 337.6 fps 10 Tap: 284 fps
2 Tap: 13.44 ms 2 Tap: N/A
4 Tap: 6.73 ms 4 Tap: N/A
8 Tap: N/A 8 Tap: 3.38 ms 8 Tap: 4.41 ms
10 Tap: N/A 10 Tap: 2.96 ms 10 Tap: 3.51 ms

Pixel Data Format

8 bit (2/4 Tap)
10 bit (2/4 Tap)

8 bit (2/4/8/10Tap)

_ 8 bit (8/10Tap)
10 bit (2/4/8 Tap)

Camera Link Pixel Clock

85 Mz

Exposure Time

1/100000 ~ 7 sec (10 us step)

Cable Length

<5 m (Camera Link Cable at 85 M)

Black Offset 0 ~ 63 LSB, 64 step
Video Gain 0~12 dB, 64 step
Trigger Mode Free-Run, Trigger / Programmable Exposure Time and Trigger Polarity

External Trigger

External, 3.3V ~ 5.0 V Logical level input, Optically isolated

Software Trigger

Camera Link CC1

Dynamic Range

60 dB

Lens Mount

C or F-mount

Power

10 ~ 14 V DC, Typ. 4W

10 ~14 V DC, Typ. 4W 10~14VDC, Typ.5W

Environmental

Operating: 0°C ~ 40°C, Storage: -40°C ~ 70°C

Mechanical

68 mm x 68 mm x 54 mm, 373 g (with C-mount)

Configuration SW

Configurator

Table 5.1 Specifications of VC Series (VC-2MC / VC-3MC)
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VC Series VC-4MC-80 VC-4MC-180 VC-12MC-65
Resolution (H x V) 2048 x 2048 4096 x 3072
Sensor CMOSIS CMV 4000 CMOSIS CMV 12000
. 225 mm x 16.9 mm
Sensor Size 11.2 11.2 tical F t: 1"
Gmm > 11.26 mn (Optical Format: 17) (Diagonal: 28.14 mm)
Sensor Type High Speed Progressive Scan CMOS Image Sensor
Pixel size 55 um x 5.5 um
Interface Camera Link
Electronic Shutter Global Shutter
2 Tap: 39.6 fps 2 Tap: 13.0 fps
4 Tap: 78.9 fps 4 Tap: 26.0 fps
Max. Frame Rate
8 Tap: N/A 8 Tap: 157.1 fps 8 Tap: 51.7 fps
10 Tap: N/A 10 Tap: 179.5 fps 10 Tap: 64.3 fps
2 Tap: 25.3 ms 2 Tap: 76.9 ms
] 4 Tap: 12.67 ms 4 Tap: 38.5 ms
Transfer Time
8 Tap: N/A 8 Tap: 6.37 ms 8 Tap: 19.4 ms
10 Tap: N/A 10 Tap: 5.58 ms 10 Tap: 15.6 ms
8 bit (2/4 Tap) 8 bit (2/4/8/10Tap) 8 bit (2/4/8/10 Tap)
Pixel Data Format
10 bit (2/4 Tap) 10 bit (2/4/8 Tap) 10 bit (2/4/8 Tap)
Camera Link Pixel Clock 85 Mz
Exposure Time 1/100000 ~ 7 sec (10 ps step) 5/100000~7sec (10 ps step)

<5 m (Camera Link Cable at 85 Miz)
0~ 63 LSB, 64 step
0~12 dB, 64 step

. Free-Run, Trigger
Trigger Mode ' : :
Programmable Exposure Time and Trigger Polarity

External, 3.3 V ~ 5.0 V Logical level input, Optically isolated

Cable Length
Black Offset

Video Gain

External Trigger

Camera Link CC1
60 dB

Software Trigger

Dynamic Range

C or F-mount F-mount

10~14V DC, Typ.4W | 10~14VDC, Typ.4W | 10~14VDC, Typ.5W

Lens Mount

Power

Environmental Operating: 0°C ~ 40°C, Storage: -40°C ~ 70°C

Mechanical 68 mm x 68 mm x 54 mm, 373 g (with C-mount) 68x68x80, 432g(F-mount)

Configuration SW Configurator

Table 5.2 Specifications of VC Series (VC-4MC / VC-12MC)
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VC Series VC-25MC-30 VC-25MC-30 D
Resolution (H x V) 5120 x 5120
Sensor On Semiconductor VITA-25K On Semiconductor PYTHON-25K
Sensor Size 23.94 mm x 23.04 mm 23.94 mm x 23.04 mm
(Optical Format: 35 mm) (Diagonal: 32.6 mm)
Sensor Type High Speed Progressive Scan CMOS Image Sensor
Pixel size 4.5 um x 4.5 um
Interface Camera Link
Electronic Shutter Global Shutter
2 Tap: N/A
4 Tap: N/A
Max. Frame Rate
8 Tap: 25.0 fps 8 Tap: 25.3 fps
10 Tap: 30.9 fps 10 Tap: 31.9 fps
2 Tap: N/A
4 Tap: N/A
Transfer Time
8 Tap: 40.00 ms 8 Tap: 39.52 ms
10 Tap: 32.36 ms 10 Tap: 31.34 ms
Pixel Data Format 8 bit (8/10 Tap), 10 bit (8 Tap)
Camera Link Pixel Clock 85 Mz
Exposure Time 1/100000 ~ 7 sec (10 us step)
Cable Length <5 m (Camera Link Cable at 85 M)
Black Offset 0~ 63 LSB, 64 step
Video Gain 0~ 12 dB, 64 step
Trigger Mode Programmable Elj(:)eoes-i:n'i'i-rrr:f gi; Trigger Polarity
External Trigger External, 3.3 V ~ 5.0 V Logical level input, Optically isolated
Software Trigger Camera Link CC1
Dynamic Range 54 dB 59 dB
Lens Mount F-mount
Power 10~14V DC, Typ.6 W 10~14V DC, Typ. 7W
Environmental Operating: 0°C ~ 40°C, Storage: -40°C ~ 70°C
Mechanical 68 mm x 68 mm x 54 mm, 432 g (with F-mount)
Configuration SW Configurator

Table 5.3 Specifications of VC Series (VC-25MC-30 / VC-25MC-30 D)
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5.3 Camera Block Diagram

DDR2 -
Ext. Trig

FPGA

16 / 32 Channel
LVDS Image Data Image
. Strobe
Processin
CMOS 9
< And
ensor SPI Control Control
b Logic

uoneinbiuod
[Ind YulTelswed

MicroController L
EEPROM (

A 4 A 4

‘ FLASH H SRAM

Figure 5.1 Camera Block Diagram

All controls and data processing of VC cameras are carried out in one FPGA chip. The FPGA generally consists
of a 32 bit RISC Micro-Controller and Processing & Control Logic. The Micro-Controller receives commands from
the user through the Camera Link interface and then processes them. The Processing & Control Logic
processes the image data received from the CMOS sensor and then transmits data through the Camera Link
interface. And also, the Processing & Control Logic controls the trigger inputs and strobe outputs which are
sensitive to time. Furthermore, FLASH and DDR2 is installed outside FPGA. DDR2 is used to process images

and FLASH contains the firmware that operates the Micro-Controller.
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5.4 Sensor Information

The following graphs show the spectral response for VC-2MC monochrome and color camera.

CMV2000 Spectral response
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Figure 5.2 Mono Spectral Response for VC-2MC
CMV2000 color spectral reponse
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Figure 5.3 Color Spectral Response for VC-2MC
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The following graph shows the spectral response for VC-3MC monochrome and color camera.
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Figure 5.4 Mono and Color Spectral Response for VC-3MC
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The following graphs show the spectral response for VC-4MC monochrome and color camera.
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Figure 5.5 Mono Spectral Response for VC-4MC
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Figure 5.6 Color Spectral Response for VC-4MC
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The following graph shows the spectral response for VC-12MC monochrome and color camera.
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Figure 5.7 Mono and Color Spectral Response for VC-12MC
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The following graph shows the spectral response for VC-25MC-30 monochrome and color camera.
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Figure 5.8 Mono and Color Spectral Response for VC-25MC-30

The following graph shows the spectral response for VC-25MC-30 D monochrome and color camera.
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Figure 5.9 Mono and Color Spectral Response for VC-25MC-30 D
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5.5 Mechanical Specification

The camera dimensions in millimeters are as shown in the following figures.

(Mechanical FB)
A _ 8-M5DP S

M25.4 x P0.794 e
/ C-'hun(xThrud 87 _| . '_.—me'i Mounting Screw Holes

i = 2 - Glass \ :
‘ © ]
I Y ! o= §!
E iz ||| : 3
3 L z E"
L -]

1 - | !

le 68.0'%0s . Image Plane 2@‘ . Siin. |
n2 |1, 393 67.8(Rear Block)

_. Reference Plane(Side)
.~/ for Camera Mounting
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Figure 5.10 VC-2MC /3MC / 4MC Camera Link C-mount Mechanical Dimension
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Figure 5.11 VC-2MC / 3MC / 4MC Camera Link F-mount Mechanical Dimension
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Figure 5.12 VC-12MC / 25MC Camera Link F-mount Mechanical Dimension
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6 Connecting the Camera

The following instructions assume that you have installed a Camera Link frame grabber in your PC including
related software. For more information, refer to your Camera Link frame grabber User Manual.
To connect the camera to your PC, follow the steps below:
1. Make sure that the power supply is not connected to the camera and your PC is turned off.
2.  Plug one end of a Camera Link cable into the Camera Link connector on the camera and the other
end of the Camera Link cable into the connector on your Camera Link frame grabber.
Connect the plug of the power adaptor to the power input connector on the camera.
4. Plug the power adaptor into a working electrical outlet.

5. Verify that all the cable connections are secure.

6.1 Mount Plate

*  The Mount Plate is provided as an optional item.

e The camera can be fixed without using this Mount Plate.
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6.2 Precaution to center the image sensor

* User does not need to center the image sensor as it is adjusted as factory default settings.
*  When you need to adjust the center of image sensor, please contact your local dealer or the manufacturer

for technical assistance.

6.3 Precaution about blurring compared to the center

e User does not need to adjust the tilt as it is adjusted as factory default settings.
e If the tilt settings need to be adjusted inevitably, please contact your local dealer or factory representative for

technical support.

6.4 Controlling the Camera

*  You can control the camera by executing the Configurator.exe file.

¢  You can download the latest Configurator at http://www.vieworks.com.

e Please refer to your Camera Link frame grabber user manual.
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7 Camera Interface

7.1 General Description

As shown in the following figure, 4 types of connectors and status indicator LED are located on the back of the

camera and have the functions as follows:

e (O 26 pin Camera Link Connector 1 (Base): controls video data transmission and the camera.

* (2 26 pin Camera Link Connector 2 (Medium/Full): transmits video data

e (3 Status LED: displays power status and operation mode.
e (@ 6 pin Power Input Connector: supplies power to the camera.
¢ (® 4 pin Control Connector: inputs external trigger signal and outputs strobe.

© ‘i @
M —=\E

Figure 7.1 VC Series Back Panel

7.2 Camera Link Connector

dle==

26 14

Figure 7.2 Camera Link Connector
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Camera output complies with Camera Link Standard and the following list shows the pin configuration of the

connector.

PAIR List Description
1 Ground Ground Cable Shield
PAIR O
14 Ground Ground Cable Shield
2 -X0 LVDS - Out Camera Link Transmitter
PAIR 1
15 +X0 LVDS - Out Camera Link Transmitter
3 -X1 LVDS - Out Camera Link Transmitter
PAIR 2
16 +X1 LVDS - Out Camera Link Transmitter
4 -X2 LVDS - Out Camera Link Transmitter
PAIR 3
17 +X2 LVDS - Out Camera Link Transmitter
5 -XCLK LVDS - Out Camera Link Transmitter
PAIR 4
18 +XCLK LVDS - Out Camera Link Transmitter
6 -X3 LVDS - Out Camera Link Transmitter
PAIR 5
19 +X3 LVDS - Out Camera Link Transmitter
7 + SerTC LVDS - In Serial Data Receiver
PAIR 6
20 - SerTC LVDS - In Serial Data Receiver
8 - SerTFG LVDS - Out Serial Data Transmitter
PAIR 7
21 + SerTFG LVDS - Out Serial Data Transmitter
9 -CC1 LVDS - In Software External Trigger
PAIR 8
22 +CC1 LVDS - In Software External Trigger
10 N/C N/C N/C
PAIR 9
23 N/C N/C N/C
11 N/C N/C N/C
PAIR 10
24 N/C N/C N/C
12 N/C N/C N/C
PAIR 11
25 N/C N/C N/C
13 Ground Ground Cable Shield
PAIR 12
26 Ground Ground Cable Shield
Table 7.1 Pin Assignments for Camera Link Connector 1
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PAIR List Description
1 Ground Ground Cable Shield
PAIR O
14 Ground Ground Cable Shield
2 -YO0 LVDS - Out Camera Link Transmitter
PAIR 1
15 +Y0 LVDS - Out Camera Link Transmitter
3 -Y1 LVDS - Out Camera Link Transmitter
PAIR 2
16 +Y1 LVDS - Out Camera Link Transmitter
4 -Y2 LVDS - Out Camera Link Transmitter
PAIR 3
17 +Y2 LVDS - Out Camera Link Transmitter
5 -YCLK LVDS - Out Camera Link Transmitter
PAIR 4
18 +YCLK LVDS - Out Camera Link Clock Tx
6 -Y3 LVDS - Out Camera Link Channel Tx
PAIR 5
19 +Y3 LVDS - Out Camera Link Channel Tx
7 - Not Used
PAIR 6 Connected with 100 ohm
20 - Not Used
8 -Z0 LVDS - Out Camera Link Transmitter
PAIR 7
21 +Z0 LVDS - Out Camera Link Transmitter
9 -Z1 LVDS - Out Camera Link Transmitter
PAIR 8
22 +Z1 LVDS - Out Camera Link Transmitter
10 -Z2 LVDS - Out Camera Link Transmitter
PAIR 9
23 +72 LVDS - Out Camera Link Transmitter
11 -ZCLK LVDS - Out Camera Link Transmitter
PAIR 10
24 +ZCLK LVDS - Out Camera Link Clock Tx
12 -Z3 LVDS - Out Camera Link Channel Tx
PAIR 11
25 +Z3 LVDS - Out Camera Link Channel Tx
13 Ground Ground Cable Shield
PAIR 12
26 Ground Ground Cable Shield

Table 7.2 Pin Assignments for Camera Link Connector 2
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Model Camera Link Output Mode  CL Configuration @ CL Connector1 CL Connector 2

2 Tap BASE o] X
VC-2MC-340

4 Tap MEDIUM 0] @]
VC-4MC-180

8 Tap FULL 0] @]
VC-12MC-65

10 Tap FULL O @)
VC-3MC-280 8 Tap FULL O @)
VC-25MC-30

10 Tap FULL 0] @]

VC-25MC-30 D

Table 7.3 Connector Arrangement for Camera Link Output Modes

When you connect a Frame Grabber to Camera Link Connectors using Camera Link cables,
make sure you connect to the correct Camera Link Connector. Incorrect connection of

Connector 1 and Connector 2 may cause malfunction of the camera or communication

problems between PC and the camera.
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7.3 Power Input Connector

The power input connector is a Hirose 6 pin connector (part # HR10A-7R-6PB). Pin arrangement and

configuration are as follows:

Figure 7.3 Pin Arrangement of Power Input Connector

Pin Number Description
1,2,3 +12V DC Input DC Power Input
4,5,6 DC Ground Input DC Ground

Table 7.4 Pin Configuration of Power Input Connector
Connecting the power cable to the camera can be made by using the Hirose 6 pin plug (part # HR10A-7P-6S) or
the equivalent. The power adaptor is recommended to have at least 1A current output at 12 V DC £10% voltage

output (Users need to purchase the power adaptor separately).

Precaution for Power Input

* Make sure the power is turned off before connecting the power cord to the camera.

Otherwise, damage to the camera may result.

» If the voltage applied to the camera is greater than specified in the specifications, damage

CAUTION
to the camera may result.
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7.4 Control Connecter

The control connector is a Hirose 4 pin connector (part # HR10A-7R-4S) and consists of an external trigger

signal input and strobe output port. Pin arrangement and configuration are as follows:

Figure 7.4 Pin Arrangement of Control Connector

Pin Number Description
1 Trigger Input + Input -
2 Trigger Input - Input -
3 DC Ground - DC Ground
3.3 V TTL Output
4 Strobe Out Output
Output resistance: 47 Q

Table 7.5 Pin Configuration of Control Connector

The mating connector is a Hirose 4 pin plug (part # HR10A-7P-4P) or the equivalent connectors.
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7.5 Trigger Input Circuit

Following figure shows trigger signal input circuit of the 4-pin connector. Transmitted trigger signal is applied to
the internal circuit through a photo coupler. Minimum trigger width that can be recognized by the camerais 1 ps.
If transmitted trigger signal is less than 1 ps, the camera will ignore the trigger signal. External trigger circuit

example is shown below.

+5V

0
1k0i
<

/ \ ] 330 0
STROBE_OUT + OHO TRIGGER_IN+ > % 5> TRIGGER_IN

(059 — N
@ @ TRIGGER_IN
é HR10A-7R-4SB PHOTO COUPLER $

Figure 7.5 Trigger Input Schematic

Output Resistance < 100 Q
AN\ > TRIGGER_IN +: Pin 1

Pulse Width > 1us éD
Amplitude Range: 3V ~5V |

> TRIGGER_IN - : PIN 2

Figure 7.6 Recommended Pulse Trigger Driver Input

ON Resistance <100 Q

i avs > TRIGGER_IN - : Pin 2

Minimum I{

ON Time > 1lus ‘7 N
> GROUND  :PIN3

Figure 7.7 Recommended Contact Trigger Input
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7.6 Strobe Output Circuit

The strobe output signal is 3.3 V output level of a TTL Driver IC. The pulse width of signal is synchronized with

the exposure signal (shutter) of the camera.

STROBE_SIGNAL

S W V4

@\ >> TRIGGER_IN +

l\ N STROBE_OUT /_
@
I/>c

TTL Driver ( @

©) ) >> TRIGGER_IN -

L e

HR10A-7R-4SB

Figure 7.8 Strobe Output Schematic

Page 32 of 89

RA14-11A-010



VIEWOrkKks

VC Camera Link series

8 Camera Features

8.1 Region Of Interest (ROI)

The Region of Interest (ROI) feature allows you to specify a portion of the sensor array. You can acquire only the
frame data from the specified portion of the sensor array while preserving the same quality as you acquire a
frame from the entire sensor array. ROl is determined as the overlapping area of two areas when designating
start point and end point in horizontal and vertical direction as shown in the figure below. Start point and End
point mean the starting and end of the ROI. In the VC-2MC, 4MC and 12MC models, the frame rate will increase
as the vertical ROl is made smaller. However, the horizontal ROl does not affect the frame rate. In the VC-3MC

and VC-25MC models, the frame rate will increase as both the vertical and horizontal ROl are made smaller.

(0,0) (HSIZE - 1, 0)
Horizontal ROI

“— V Start

Vertical

ROI
«<— VEnd

(0, VSIZE - 1) | ‘ (HSIZE - 1, VSIZE - 1)
H Start H End
Figure 8.1 ROI

In VC-2MC, the maximum frame rates depending on the changes of vertical ROl are shown in the table below.

ROI Size (H x V) 2Tap 4Tap ~ 8Tap 10 Tap
2048 x 16 3689.3 fps 6692.2 fps 10622.3 fps 12103.0 fps
2048 x 32 2094.4 fps 4036.9 fps 6979.1 fps 7960.3 fps
2048 x 64 1123.3 fps 2250.8 fps 4139.6 fps 4725.4 fps

2048 x 128 582.8 fps 1194.1 fps 2282.4 fps 2606.7 fps
2048 x 256 297.0 fps 615.9 fps 1203.0 fps 1374.3 fps
2048 x 512 149.9 fps 312.9 fps 618.2 fps 706.4 fps
2048 x 1024 75.3 fps 157.7 fps 313.5 fps 358.2 fps

Table 8.1 VC-2MC Maximum Frame Rate depending on ROI Size
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In VC-3MC, the maximum frame rates depending on the changes of both horizontal and vertical ROl are shown
in the following table.

ROI Size (H x V) 8 Tap 10 Tap
640 x 480 1830 fps 2288 fps
1024 x 768 807 fps 1010 fps
1280 x 1024 486 fps 632 fps
1600 x 1200 346 fps 432 fps
1680 x 1680 229 fps 296 fps
1696 x 1710 227 fps 284 fps

Table 8.2 VC-3MC Maximum Frame Rate depending on ROI Size

In VC-4MC, the maximum frame rates depending on the changes of vertical ROl are shown in the following
table.

ROI Size (H x V) 2Tap  4Tap  8Tap 10 Tap
2048 x 16 3689.3 fps 6692.2 fps 10622.3 fps 12103.0 fps
2048 x 32 2094.4 fps 4036.9 fps 6979.1 fps 7960.3 fps
2048 x 64 1123.3 fps 2250.8 fps 4139.6 fps 4725.4 fps
2048 x 128 582.8 fps 1194.1 fps 2282.4 fps 2606.7 fps
2048 x 256 297.0 fps 615.9 fps 1203.0 fps 1374.3 fps
2048 x 512 149.9 fps 312.9 fps 618.2 fps 706.4 fps
2048 x 1024 75.3 fps 157.7 fps 313.5 fps 358.2 fps
2048 x 2048 39.6 fps 78.9 fps 157.1 fps 179.5 fps

Table 8.3 VC-4MC Maximum Frame Rate depending on ROI Size

In VC-12MC, the maximum frame rates depending on the changes of vertical ROl are shown in the following
table.

ROI Size (H x V) 2 Tap 4 Tap ‘ 8 Tap 10 Tap
4096 x 500 78 fps 156 fps 304.1 fps 377.9 fps
4096 x 1000 39 fps 79 fps 155.8 fps 193.6 fps
4096 x 1500 26 fps 52 fps 104.7 fps 130.1 fps
4096 x 2000 19 fps 39 fps 78.9 fps 98.0 fps
4096 x 2500 15 fps 31 fps 63.2 fps 78.6 fps
4096 x 3072 13 fps 25 fps 51.6 fps 64.0 fps

Table 8.4 VC-12MC Maximum Frame Rate depending on ROI Size

Page 34 of 89 RA14-11A-010



VIBEWOrkKs VC Camera Link series

In VC-25MC, the maximum frame rates depending on the changes of both horizontal and vertical AOI are shown

in the following table.

VC-25MC-30 VC-25MC-30 D

ROI Size (H x V) 8 Tap 10 Tap 8 Tap 10 Tap
3000 x 3000 56.4 fps 69.8 fps 54.9 fps 69.2 fps
4000 x 3000 48.8 fps 60.4 fps 48.7 fps 61.3 fps
4000 x 4000 36.7 fps 454 fps 36.6 fps 46.1 fps
5120 x 5120 25.0 fps 30.9 fps 25.3 fps 31.9 fps

Table 8.5 VC-25MC-30 and VC-25MC-30 D Maximum Frame Rate depending on ROI Size

* The ROl values (H x V) may vary depending on the type of Camera Link frame grabber.
For technical assistance, contact your local dealer or the manufacturer.

*  The ROI setting commands for VC-12MC are different from the other models since it

CAUTION supports the Multiple ROI feature. Refer to Table 9.4 Command List #4 for the related

commands.
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8.2

Multi-ROI (VC-12MC/VC-25MC Only)

The VC-12MC-65, VC-25MC-30 and VC-25MC-30 D cameras provide the Multi-ROI feature which allows you to

define up to thirty two regions on the sensor array. When an image is acquired, only the pixel information from

the defined regions will be readout of the sensor. The pixel data read out of the regions will then be combined

together and will be transmitted from the camera as a single image.

8.2.1

Multi-ROI on VC-12MC

It is recommended that you first set the Offset X and Width parameters, since all of the regions must be the

same width and all of the regions must be vertically aligned. The next step in the setup process is to define each

individual region in order. Up to 32 regions can be set up ranging from 0 through 31. Set the each region to

ON/OFF and then set the Offset Y (the offset between the top of the sensor and the top of the region) and

Height (the height of the region) values to define each region. In figure 8.2, for example, three regions have

been set. With these settings, the camera would output an image with 2048 (width) x 1844 (the total height of

the three regions) size.
Offset X = 1024, Width = 2048

ROI_0

s Offset Y = 204, Height = 512

ROI_1

o OffsetY = 1024, Height = 716

ROI_2

s OffsetY = 2356, Height =616

Figure 8.2 Multi-ROI (VC-12MC)
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There are several things to keep in mind when setting the Multi-ROI feature on the VC-12MC camera:

The sum of the Offset X value plus the Width value must not exceed the width (4096 on the VC-12MC) of
the camera’s sensor.

The sum of the Offset Y value plus the Height value must not exceed the height (3072 on the VC-12MC) of
the camera’s sensor.

The Offset X value must be a multiple of 8.

The Width value must be a multiple of 8 ranging from 24 to 4096.

The Offset Y and Height values must be a multiple of 4 ranging from 4 to 3072.

You need to set the regions in order. When you set a preceding region to OFF, all the succeeding regions
will be set to OFF automatically. For example, you have set four regions from 0 through 4. If you set the
region 1 to OFF, the region 2, 3 and 4 will be set to OFF.

You do not need to order the regions from top to bottom on the sensor. For example, you could place the
region 1 near the bottom of the sensor, the region 2 near the top, and the region 3 in the middle.

You can save (Configurator > File > Save Setting > User 1 or User 2) the setting values for Multi-ROI to
parameter storage space and then load (Configurator > File > Load Setting > From User 1 Space or
From User 2 Space) the values to the camera when desired.

Refer to Table 9.4 Command List #4 for the commands related to Multi-ROI.
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8.2.2

Multi-ROI on VC-25MC

It is recommended that you first set the Width parameter, since all of the regions must be the same width. The

next step in the setup process is to define each individual region as desired. Up to 32 regions can be set up
ranging from 0 through 31. Set the each region to ON/OFF and then set the Offset X, Offset Y and Height (the

height of the region) values to define each region. In figure 8.3, for example, three regions have been set. With

these settings, the camera would output an image with 1280 (width) x 4660 (the total height of the three

regions) size.
Width = 1280
ROI_0

Offset X = 600, Offset Y = 0, Height = 1280
ROI_1
Offset X = 1984, Offset Y = 1420, Height = 2100
ROI_2
Offset X = 3264, Offset Y = 3720, Height = 1280

a

a

o

ROI_2 Offset X Width

ROI_1 Offset X . Width

Offset X, Width

L

ROI_2 Offset Y

ROI_1 Hei

ROI_2 Height

ROI_1 Offset Y
ROI_0 Hei

ght

1

ght

gooooooog

o
8]
u)
o
8]
8]
o
o
=]

ngoooopooopdooopoooooooooooooQan

goooooaoooooiooocoooogooooooPpoooOoouoooooooon
pooooooooooDoooooogooooooooooOouoooopocon00
ooooooooooooio o0 00000OOoOooooooOOONooCco00g

Figure 8.3 Multi-ROI (VC-25MC)
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There are several things to keep in mind when setting the Multi-ROI feature on the VC-25MC-30 and VC-25MC-

30 D cameras:

The sum of the Offset X value plus the Width value must not exceed the width (5120 on the VC-25MC-30 /
VC-25MC-30 D) of the camera’s sensor.

The sum of the Offset Y value plus the Height value must not exceed the height (5120 on the VC-25MC-30 /
VC-25MC-30 D) of the camera’s sensor.

The Offset X value must be a multiple of 64.

The Width value must be a multiple of 64 ranging from 256 to 5120.

You can save (Configurator > File > Save Setting > User 1 or User 2) the setting values for Multi-ROI to
parameter storage space and then load (Configurator > File > Load Setting > From User 1 Space or
From User 2 Space) the values to the camera when desired.

If you make changes to the Multi-ROI settings, you must execute the ‘ast’ command to apply the changes.
If you attempt to set the Multi-ROI settings with invalid values, the camera will not acquire images.

Refer to Table 9.4 Command List #4 for the commands related to Multi-ROI.
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8.3 Binning (VC-25MC Monochrome Only)

Binning has the effects of increasing the level value and decreasing resolution by adding the values of the
adjacent pixels and sending them as one pixel. VC-25MC provides two binning factor (x1 and x2) that the user
can apply both horizontally and vertically. The below figure shows application of 2 x 2 binning, four pixels are
summed and reported out of the camera as a single pixel. Using binning reduces the resolution of camera’s
imaging sensor in half, however, it results in double signal to noise ratio with the same brightness as an original

image. You can set the Binning Factor by using the ‘sbf’ command.

A0

Figure 8.4 2 x 2 Binning
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8.4 Exposure

The CMOS sensor of VC series uses global shutter that exposes the entire imager simultaneously. The below

figure illustrates the timing of exposure and readout of CMOS sensor. Readout is performed consecutively from

first to last line where readout defines the process of reading the accumulated charges on pixels. Readout Time

(also called Transfer Time) defines the rate at which one frame of an image is transferred.

! Start of exposure ! End of exposure
L 7%
1 X "

X

Trigger Signal

Input

Image

Readout Readout Time

v

Figure 8.5 Exposure Timing Diagram
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8.4.1 Real Exposure (VC-12MC Only)
In VC-12MC-65, when you set the Trigger Mode to Free-Run or the Exposure Mode to Program, the exposure

time will be determined by the user settings (‘set’ command). With these settings, the camera will generate
trigger signals internally. As soon as the camera detects a trigger signal, the camera will begin a frame exposure.
When the exposure time ends, the pixels are being sampled and prepared for readout. This sequence is called
the frame overhead time (FOT). Immediately after the FOT, the frame is read out automatically. During the FOT,
an additional exposure time will be applied as the offset value shown in the Figure 8.5. This offset value varies
depending on the camera’s Camera Link Output Mode settings. The setting value on the exposure time is equal
to actual exposure time, because the offset value is compensated on the actual exposure time. In 8 tap output
channel mode, for example, the exposure time is set to 200 ps. The camera will subtract offset value 50 us

from the exposure time setting internally, and thus the actual exposure time will be 200 us as the user settings.

Due to the offset value, the minimum exposure time is limited as shown in the Table 8.6.

| "tﬂr" ﬂl Tri gger b

1
5
E
2
3
=
a

e Offsete:

Frame Cycle

Figure 8.6 Real Exposure for VC-12MC-65

Camera Link Output Mode Offset Value

2 Tap 50 ps
4 Tap 50 ps
8 Tap 50 ps
10 Tap 40 ps

Table 8.6 Offset Value for VC-12MC-65

2 Tap 50 us
4 Tap 50 us
8 Tap 50 us
10 Tap 40 ps

Table 8.7 Minimum Exposure Time for VC-12MC-65
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8.5 Trigger Mode

Trigger mode of the camera is divided into Free-Run mode where image is synchronized to Internal Trigger
signal created inside the camera and External Sync mode where image is synchronized to the trigger signal

entered into the external port.

85.1 Free-Run Mode

In Free-Run mode, the period of internal trigger signal is determined by Transfer Time (1 Frame data
transmission time) and Exposure setting value, and image is obtained with this periodic signal. Frame Rate, the
period of internal signal, is determined with the following two conditions.
e Case 1: Exposure Time < Frame Transfer Time

= Frame Rate(FPS) = 1/ Frame Transfer Time (sec) — has a fixed value.
e Case 2: Exposure Time > Frame Transfer Time

= Frame Rate(FPS) = 1/ Exposure Time (sec) — varies depending on Exposure Time value.

Transfer Time

y_ _

—————x—

| |
[ »l
" Exposure g
: SettingTime :
Internal
Trigger
Exposure Image N-1 Image N Image N +1
Frame Transfer Image N-1 Image N
Figure 8.7 Exposure Time is shorter than Readout Time
L Exposure Setting Time |
: Transfer Time | :
L (Readout Time) K |
i~ gl |
| | |
| | |
| |
T
Internal [ J
Trigger |
|
|
Exposure Image N-1 Image N | Image N + 1
|
|
Frame Transfer Image N-1 Image N

Figure 8.8 Exposure Time is longer than Readout Time
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8.5.2 External Sync Mode

In External Sync Mode, camera keeps standby status until trigger signal is entered, and when trigger is entered,
the image is transmitted (frame transfer) after exposure process. To operate the camera in External Sync mode,
it is required to set Trigger Source regarding which input, CC1 input port or External Trigger port, will be used for

trigger signal, as well as Polarity and Exposure source of the signal entered.

|
l': =: Trigger Pulse Width
|
External Trigger
(CC1 or External)
EXPOSURE Exposure Time
|
Data Transfer Transfer Time

Figure 8.9 External Sync Mode

Following is the summary of basic setting items.

e Trigger Source: select either CC1 (Camera Control Port 1) or External Connector as source of the
external trigger input signal.

e Trigger Polarity: set whether polarity of Trigger signal entered is Active High or Active Low.

e  Exposure Source: select to synchronize exposure time with pulse width of trigger input signal or with

exposure time programmed inside the camera.
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8.5.3

Overlap Trigger Input

When trigger is entered during frame transfer as shown in the figure below, it performs exposure process for

newly entered trigger while transferring the previous data. In this case, shooting images is possible up to the

maximum frame rate (speed of 1/Transfer Time (sec)) regardless of the exposure time.

External Trigger

(CC1 or External)

EXPOSURE

Strobe Out

Data Transfer
(FVAL)

le

Exposure Sourqe (Pulse width / Program exposure time )

i

gl

Exposure N

Exposure N+1

Exposure N+2

N

Image N

N

Image N+1

N

Image N+2

Figure 8.10 Camera Operation when Overlap Trigger is entered

Following list shows the operation of camera on exceptional trigger input.

*  When the trigger signal with the faster period than the maximum frame rate condition is entered, the next

frame transfer is performed before completing the previous frame transfer. This causes the failure of

obtaining overall image.

* If new trigger is entered during the exposure process after Exposure Source is set as Program, the newly

entered signal will be ignored. In this case, exposure time is longer than trigger input period and the frame

rate will be slower than trigger input period since all the entered trigger signals cannot synchronize.
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8.6 Camera Link Output

VC Series supports 2 Tap, 4 Tap, 8 Tap or 10 Tap output modesT according to the user interface. Tap setting
value defines the number of output pixel data for each Pixel Clock Cycle (85 M), and the speed of frame data
transmission varies depending on the tap setting. Frame Data is output in interleaved order as shown in the

figure below. This tap setting can be set using the ‘scl’ command.

AlB ! AlB - 2 Tap Output
«— 1 Pixel Clock Cycle (BASE *1)
AlBIC|D . AlB — 4 Tap Output
» 1 Pixel Clock Cycle (MEDIUM *1)
A B/ C D E F| G H | AlB mm 8 Tap Output
< » 1 Pixel Clock Cycle (FULL *1)
A/B/CIDE/FGH I |J A B = Tap Output
¥ > (FULL *1)

1 Pixel Clock Cycle

*1 : Camera-Link Configuration

Figure 8.11 Camera Link Output Mode

1 Supported Camera Link Output Mode

* VC-2MC-150 and VC-4MC-80 support 2 Tap and 4 Tap.

e VC-2MC-340, VC-4MC-180 and VC-12MC-65 support 2 Tap, 4 Tap, 8 Tap and 10 Tap.
e VC-3MC-280, VC-25MC-30 and VC-25MC-30 D support 8 Tap and 10 Tap.
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8.7 Gain and Offset

Gain and Offset can be changed through Voltage Reference adjustment which is applied commonly to all ADCs.
Gain adjustment can be set among 0 ~ 12 dB and setting value can be set as a value from 0 to 64 step.

Relation between setting value and actual Gain (dB) is shown below:

Gain (dB) = (setting value) X 0.19 dB
Gain Curve
12
10

Gain(dB)

0 16 32 48 6
Register Value 3

Figure 8.12 Register Setting vs Gain

Offset can be set between 0 ~ 63 (LSB) based on 8 bit data output and setting value has 64 step values.
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8.8 Defective Pixel Correction

The CMOS sensor may have Defect Pixels which cannot properly react to the light. Correction is required since
it may deteriorate the quality of output image. Defect Pixel information of CMOS used for each camera is entered
into the camera during the manufacturing process. If you want to add Defect Pixel information, it is required to
enter coordinate of new Defect Pixel into the camera.

For more information, refer to Appendix A. The ‘sdc’ command is used to set whether to use Defective Pixel

Correction feature.

8.8.1 Correction Method

Correction value for Defect Pixel is calculated based on valid pixel value adjacent in the same line.

L3 L2 L1 R1 R2 R3

T

<Current Pixel>

Figure 8.13 Location of Defect Pixel to be corrected

If Current Pixel is a Defect Pixel as shown in the above figure, correction value of this pixel is obtained as shown

in the following table depending on whether surrounding pixel is Defect Pixel or not.

Adjacent Defect Pixel(s) Correction value of Current Pixel

None (L1+R1)/2
L1 R1
R1 L1

L1, R1 (L2+R2)/2
L1, R1, R2 L2
L2, L1, R1 R2

L2, L1,R1,R2 (L3+R3)/2
L2,L1,R1,R2,R3 L3
L3, L2,L1,R1,R2 R3

Table 8.8 Calculation of Defect Pixel Correction Value
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8.9 Flat Field Correction (vc-2mC-340/VC-4MC-180/VC-12MC/VC-25MC Only)

The Flat Field Correction feature improves the image uniformity when you acquire a non-uniformity image due to

external conditions. The Flat Field Correction feature can be summarized by the following equation:

IC = IR / IF

IC: Level value of corrected image;
IR: Level value of original image;
IF: Level value of Flat Field data.

8.9.1 Sequence of Flat Field Correction

Under actual conditions, generate Flat Field Correction data and save the Flat Field Correction data into the

camera’s non-volatile memory according to the following procedures.

How to generate Flat Field Correction data using Configurator
1. Select the FFC tab and then click the Generate button in the FFC Data category to execute the Flat Field

Generator.
2. Acquire one image by operating the camera in the Free-Run mode or by applying an exposure start trigger
signal to the camera.
In the View tab, click the Flat Field Corr. check box in the Image Processing category to enable the FFC.
4. Inthe FFC tab, click the Save to Flash button in the Flash Memory category to save the generated Flat
Field Correction data into the non-volatile memory. The scaled down Flat Field data will be expanded and

then applied as shown in the Figure 8.16 when they are used for correction.

@ Vieworks - VC-12MC-C65 == 3]
File Start-Up Tool About

VIEW | MODE/EXP | ANALOG | FFC

FFC Data Flash Memory

Load from Flash
1 2 4 8 16
— Save to Flash
Generate

FFC Data Download / Upload

Number of acquisition frame

Download to camera | | Upload to PC

FFC Offset Level

0 2047 4095

VC-12MC-C65 soic  [E)vazi02

Figure 8.14 Flat Field Correction in Configurator
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How to generate Flat Field Correction data using Serial Commands

1. Use the ‘gfd’ command to execute the Flat Field Generator.

2. Acquire one image by operating the camera in the Free-Run mode or by applying an exposure start trigger
signal to the camera.
Use the ‘sfc’ command to enable the generated Flat Field Correction data.

4. Execute the ‘sfd’ command to save the generated Flat Field Correction data into the non-volatile memory.
The scaled down Flat Field data will be expanded and then applied as shown in the Figure 8.16 when they

are used for correction.

* Itis recommended that you enable the Defective Pixel correction feature before executing

the Flat Field Generator.

»  Before executing the Flat Field Generator, you must set the camera as follows:
= OffsetX, Y: 0
s Width, Height: ~ Maximum values

= Binning: 1x
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r Flat Field Calibration- - - - - - == = == = == = == = == = = = = = = = = = = = = "
| |
[ [
| |
I Scale Down = Memory I
| |
| |
| |
rFatFleldng- - - - - - - - - - -"--- -« -+ -+ - - - - -
| |
| |
| |
I Memory = Bilinear Interpolated Magnification I
| <IF=> |
| |
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| |
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Figure 8.15 Generation and Application of Flat Field Data
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Figure 8.16 Bilinear Interpolated Magnification
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8.9.2  Flat Field Selector (VC-12MC/VC-25MC Only)

As mentioned above, the active Flat Field data is stored in the camera’s volatile memory and the data is lost if
the camera is reset of powered off. To use the active or generated Flat Field data after the camera is powered on
or reset, you need to save them in the camera’s non-volatile memory. The VC-12MC-65 and VC-25MC-30
cameras provide four reserved areas, and the VC-25MC-30 D camera provides ten reserved areas in the
camera’s non-volatile memory available for saving Flat Field data. You can use the Flat Field Selector feature to

select one of the reserved areas.

Non-volatile Memory
(Flash)

T Volatile Memory

Flat Field Data 0 —
Active Flat Field Data

1

Flat Field Data 1
Flat Field Data -
Flat Field Data N

Figure 8.17 Flat Field Selector

Saving a Flat Field data

To save the current active Flat Field data into a reserved area in the camera’s flash memory,

1. Use the ‘sfs 0/1/2/--/n’ command to specify a reserved area where the current active Flat Field data will be
stored.

2. Use the ‘sfd’ command or click the Save to Flash button in Configurator to save the active Flat Field data to

the selected reserved area.

Loading the Flat Field data

If you saved a Flat Field data into the camera’s non-volatile memory, you can load the saved Flat Field data from

the camera’s non-volatile memory into the camera’s active Flat Field data.

1. Use the ‘sfs 0/1/2/--/n’ command to specify a reserved area whose Flat Field data will be loaded into the
camera’s active Flat Field data.

2. Use the ‘Ifd’ command or click the Load from Flash button to load the selected Flat Field data into the

active Flat Field data.
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8.10 High Dynamic Range (VC-2MC-M340/VC-4MC-180 Only)

When you acquire images in some situations where a bright light source or shiny materials are located within the
field of view, the light areas appear overexposed in the acquired images. And if you use a short exposure time to
avoid overexposure in the light areas of the acquired images, all details will be lost in the darker areas.

The Multiple Slop capability is implemented on the VC-2MC-M340 and VC-4MC-M180 cameras to acquire high
dynamic range (HDR) images which have higher variations between the brightest and darkest portions of the
images. As shown in the figure below, when the bright pixel reaches a certain output level, it will be maintained at
the level for a programmable time from overall exposure time. This happens two times to make sure that the

pixel is not saturated at the end of exposure time.

Resetting Pixels Sampling Pixels
i

- - - —————

Bright

Output Level of Knee Point 1

==+ Output Level of Knee Point 2

Saturation Level

Exp. Time from KP1 to End
Exp. Time from KP2 to End

Output Saturation Level

Input

Figure 8.18 High Dynamic Range Concept Drawing

To use the High Dynamic Range feature, you must set the Trigger Mode to Free-Run. Use the ‘shm’ command to
activate the HDR feature and use ‘shd n’ command to set the dynamic range in dB. The available setting range
is 0 to 40 dB.
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8.11 Sequencer for Multi-FFC (VC-25MC-30 D Only)

The Sequencer feature provided by the VC-25MC-30 D camera allows you to apply different sets of parameter

settings, called ‘Sequencer Set’, to a sequence of image acquisitions. As the camera acquires images, it applies

one Sequencer Set after the other. This allows the camera to respond quickly to changing imaging requirements.

Each Sequencer Set is identified by an index number ranging from 0 to 29. Accordingly, you can define up to 30

different Sequencer Sets. On the VC-25MC-30 D camera, only the Flat Field correction data can be configured

for Sequencer Sets. The commands related to Sequencer are as follows.

Command

Sequencer Mode

sssm

Value Description

0 Sequencer Off

1 Enables the Sequencer.
Sequencer Set Count SSsC 1~30 | Sets the number of Sequencer Sets to be applied.
n: Selects an index number of Sequencer Set to be
configured (0 ~ 29).
Sequencer Set Selector | ssss n,m
m: Selects an index number of Flat Field data to be
configured (0 ~ 9).
Reset Sequencer rssc - Returns to Sequencer Set 0.
Clears the Flat Field data that is currently selected with the
Reset Flat Field Data rfd -

Flat Field Selector (‘sfs n’).

Table 8.9 Commands related to Sequencer

CAUTION

To apply Sequencer Sets, you must first enable the Flat Field Correction feature (‘sfc 1°).
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Use Case - Applying Four Different Flat Field Correction Data to Sequencer Sets

For example, assume that four different Flat Field Correction data optimized for White, Green, Red and Blue

pixels are applied to four different Sequencer Sets to inspect LCD panels.

1. Disables the Sequencer Mode (‘sssm 0’).

2. Set the Sequencer Set Count command to 4 (‘sssc 4’).

3. Select the first Sequencer and the Flat Field data to be configured for the Sequencer by using the

Sequencer Set Selector command (‘ssss 0 0°). Then, select the second, third and fourth Sequencers and

the Flat Field data respectively (‘ssss 1 1’, ‘ssss 2 2’, ‘ssss 3 3).

4. Enables the Sequencer Mode (‘sssm 1°).

Camera in idle mode

Sequencer Mode = On &
External Exposure Start Trigger

Sequencer Mode = Off

> Exrerr] Use Case - Sequencer s
[ Exposure Start Trigger _ [
Sequencer | | Sequencer Set0 Sequencer Set 1
Reset applied to Camera | _ applied to Camera
\ Sequencer Reset \
4 4 s
= ‘=
Tt s % F T
ES 8 % ES
LW 2 %f L w
3 e 5 R Xe
> = 39’ 3
4
g 3 g
i Voo
Sequencer Set 3 Sequencer Set 2
applied to Camera | _ applied to Camera
J= External L
Exposure Start Trigger

Figure 8.19 Sequencer Diagram (Use Case)
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8.12 Auto White Balance (VC-12MC/VC-25MC Only)

The Auto White Balance feature is implemented on the VC-12MC-C65, VC-25MC-C30 and VC-25MC-C30 D
color cameras. It will control the white balance of the image acquired from the color camera according to the
GreyWorld algorithm. The entire pixel data will be used by the Auto White Balance feature to control the white
balance. As soon as you activate the Auto White Balance feature, the Digital Red, Digital Green and Digital Blue
will be set to 1. Then the Digital Red and Digital Blue will be adjusted to control the white balance. The ‘arg’

command is used to set whether to use the Auto White Balance feature.

8.13 Temperature Monitor

The camera has an embedded sensor chip to monitor the internal temperature. The ‘gct’ command is used to

check the temperature of the camera.

8.14 Status LED

There is a green LED to inform the operation status on the back of camera. LED status and corresponding

camera status are as follows:

e Continuous ON: operates in Free-Run Mode.
* Repeat ON for 0.5 second, OFF for 0.5 second:  operates in Trigger Mode.
* Repeat ON for 1 second, OFF for 1 second: outputs Test Image.

* Repeat ON for 0.25 second, OFF for 0.25 second: operates in Trigger Mode and outputs Test Image.
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8.15 Data Format

The camera processes image data in the unit of 10 bit. You can determine the data format (8 bit or 10 bitT) of

image data transmitted from the camera by using the ‘sdb 8 / 10’ command. When the camera is set for 8 bit

data format, the 2 least significant bits will be dropped from overall 10 bits.

MSB LSB
Original Data | D9 | D8 | D7 | D6 | D5 | D4 | D3 | D2 | D1 | DO

(I SR N AN SN A S AN A
10 bit Output | D9 | D8 | D7 | D6 | D5 | D4 | D3 | D2 | D1 | DO

Yy v vy v vy
8 bit Qutput | D7 | D6 | D5 | D4 | D3 | D2 | D1 | DO 5

Figure 8.20 Data Format

1 Supported data format
The VC-3MC-280 camera supports only the 8 bit data format.
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8.16 Test Image

To check normal operation of the camera, it can be set to output test image created inside, instead of image data
from the imaging sensor. There are 3 types of test image; image with different value in horizontal direction (Test
Image 1), image with different value in diagonal direction (Test Image 2), and moving image with different value

in diagonal direction (Test Image 3). Test image can be applied in all operation modes of the camera. To set Test

Figure 8.21 Test Image 1

)

Figure 8.22 Test Image 2

Image, use the ‘sti’ command.

Figure 8.23 Test Image 3
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8.17 Strobe

The camera can provide a Strobe output signal. The signal goes high when the exposure time for each frame
acquisition begins and goes low when the exposure time ends as shown in the figure below. This signal can be
used as a flash trigger and is also useful when you are operating a system where either the camera or the object
being imaged is movable. Typically, you do not want the camera to move during exposure. You can monitor the

Strobe output signal to know when exposure is taking place and thus know when to avoid moving the camera.

Shutter Signal |_| |_|

Exposure

e T s

(Active High)

Figure 8.24 Strobe Output

8.17.1 Strobe Offset (VC-25MC Only)

The Strobe Offset value specifies a delay that will be applied between the point where the shutter signal rises
and the point where the Strobe output signal rises. You can set the Strobe Offset in microseconds by using the
‘sso’ command. The width of Strobe output signal will be the same as the width of exposure but the only the

point where the Strobe output signal rises is adjusted.

Shutter Signal J_ l_

EXpOSura P ——— ————
» == - O]
Strobe ! : '
(Active High) W

Figure 8.25 Strobe Offset

8.17.2 Strobe Polarity

The Strobe Polarity is used to select Active High or Active Low triggering. You can set the polarity of the strobe

output signal by using the ‘ssp’ command.

Page 59 of 89 RA14-11A-010



VIBEWOrkKs VC Camera Link series

8.18 Field Upgrade

The camera has the function to upgrade firmware and FGPA logic through RS-644 interface of Camera Link,

rather than disassemble the camera in the field. See Appendix B for details on how to upgrade.
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8.19 Dark Image Correction

CMOS sensor may result in lower sensitivity at dark level. This is caused by fixed pattern noise variation
depending on the exposure settings or characteristic change according to the temperature variation of AFE and
sensor cell. Sensitivity change resulted by temperature variation is less than 1 dB/10 degree. The acquisition
condition of correction data is 25 degree based on the camera case temperature. To acquire optimized image at
user environment, it is recommended to perform dark image correction after the camera is installed and the

temperature of the camera is stabilized.

VC-25MC-30 and VC-25MC-30 D do not support dark image correction.

8.19.1 Sequence of Dark Image Correction

How to Correct Dark Image using Configurator

1. Prevent penetration of light into the camera image sensor.

2. Click the Generate Data button in the View tab to generate correction data.

3. Click the Save Data button to save correction data in the flash memory. The saved data will be applied to

the camera automatically when the camera is turned on.

(=) Wieworks - VL ANL C10B0

P Retle Tod Abet
VIEW NODE/DE  ANALOG 21,1y
™
* Nons
Ao
2048 (M) « 2048 (V)
*/hore
Tez 2l
Tt 22
Tat 23
woralrd Oapt  Detele Deavh Yoo 0o
*) 2 Tap (Baze) St O o
4 Tap Madur) "f:deh't |
0 Tap () e, " -
10 Ta (ol Defact Con b
VC-AMCC100 w10 i'l o

Figure 8.26 Dark Image Correction on Configurator

How to Correct Dark Image using Serial Command
1. Prevent penetration of light into the camera image sensor.
2. Use the terminal command ‘gop’ to generate correction data in the camera.

3. Use the terminal command ‘sop’ to save correction data in flash memory.
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8.20 White Pixel

If you use a VC-25MC-30 or VC-25MC-30 D camera under the condition of high ambient temperature, white
pixels (also known as hot pixels) may be occurred due to the characteristic of equipped high resolution CMOS
sensor.

White pixels are caused by accumulated current leakage in the charge storage region inside the imaging
sensor’s active pixel. If temperature is increased by seven degrees, it is getting worse with double white pixels.
To effectively reduce white pixels, maintain the operating temperature as low as possible and mount the camera
on a substantial metal component in your system to provide sufficient heat dissipation. You can also use the
defective pixel correction to remove white pixels. Add a defective pixel to defective pixel map or modify the

defective pixel map stored in the camera.

Figure 8.27 White Pixel
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9 Camera Configuration

9.1 Setup Command

All the settings for the camera are carried out through RS-644 serial interface of camera link. With the following

communication setting, it can be controlled using terminal or direct control at user application.

¢ Baud Rate: 19200 bps
* Data Bit: 8 bit

e Parity Bit: No Parity
e Stop bit: 1 stop bit
*  Flow control: None

All types of camera setting commands except Firmware Download, requiring massive data transmission are
delivered in ASCIl command type. All camera setup commands start from user application and the camera
returns the response (‘OK’, ‘Error’ or information) for the command. The camera informs the completion of
command execution through response with write command, while the camera returns the error response or

information with read command.

Command format:

<command> <parameterl> <parameter2> <cr>

0~2 parameters follow the command.

Response:

- If execution of write command is successfully completed

OK <cr> <1f>

ex) Write command

In response to a “set 100” command the camera will return (in hex value)
Command : 73 65 74 20 31 30 30 0D

set 100<cr>

Response : 73 65 74 20 31 30 30 OD OA 4F 4B 0D 0OA 3E
Set 100<cr><1f> OK<cr><1f> >
Echo result prompt
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If execution of read command is successfully completed

<parameterl> <cr> <1f>

ex) Read command

In response to a “get” command the camera will return (in hex value)

Command : 67 65 74 0D
get <cr>

Response : 67 65 74 0D OA 31 30 30 0D OA 3E
get<cr><1lf> 100<cr><1f> >
Echo response prompt

If execution of command is not completed

Error : <Error Code> <cr> <1f>

Prompt:

After sending response, Camera sends prompt always. ‘>’is used as prompt.
Types of Error Code

0x80000481 : values of parameter not valid

0x80000482 : number of parameter is not matched

0x80000484 : command that does not exist

0x80000486 : no execution right
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9.2 Actual Time Applied for Commands

When you execute a command, the actual or real time applied for the command varies depending on the type of
the command and operating status of the camera.

All commands except Set Exposure Time (‘set’) command are applied to change the settings as illustrated
below, on the rising edge of a REQ_Frame signal before starting readout process.

When you execute a ‘set’ command, the exposure time setting will be changed at the starting of the exposure.
In the Trigger mode, you must execute commands before applying trigger signals in order to synchronize image
outputs with the commands.

In the Free-Run mode, even if you execute a command, you may acquire up to two images without applying the
command. This is true because it is hard to verify the current operating status of the camera in the Free-Run

mode.

Command Command  Command ‘set’ Command, Command
Executed . Recognized J Applied Executed . Recognized

- P (Ack‘OK) p (Ack 'OK)

. Exposure Time setting

..' Applied

Command
Exposure fo Exposure for ‘
Image 1 Image 2
EXposure el | .

REQ_Frame n

I Image 1 | I Image 2
Readout

Figure 9.1 Actual Time Applied for Commands

..

— R

|
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9.3 Parameter Storage Space

The camera has 3 non-volatile storage space used for parameter storage and 1 volatile work space that is

applied to actual camera operation. 3 storage space is divided into Factory Space that contain basic value at the

factory, and 2 user space (User Space 1, User Space 2) that can save parameter value temporarily set by the

user. User space can be read and written, but Factory space can be read only.

At camera booting, setting value in one of 3 storage spaces is copied to work space according to Config

Initialization value and value of the space is used for camera setting. Since values in work space is valid only

while the power is on, it should be copied to user space 1 or user space 2 using the ‘sct’ command.

Volatile
Memory
(RAM)

Work Space

/

Non_volatile
Memory
(ROM)

4_,— < Factory Space >

— < User 1 Space >

I < User 2 Space >

Figure 9.2 Parameter Area
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9.4 Command List

Command 7 Syntax 7 Return Value } Description
Help h String Display a list of all commands
Set Read-Out Mode srm 0|1 OK 0- Normal mode
Get Read-Out Mode grm ol 1: RQI (Regio.n of Interest) mode
(ROl is set using ‘sha’ and ‘sva’ commands.)
Set Horizontal Area sha n1n2 | OK n1: Starting point of horizontal direction
Get Horizontal Area gha n1n2 n2: End point of horizontal direction
Set Vertical Area sva n1n2 | OK n1: Starting point of vertical direction
Get Vertical Area gva n1n2 n2: End point of vertical direction
Set Trigger Mode stm 01 OK 0: Free Run mode
Get Trigger Mode gtm 01 1: Trigger/Overlap mode
Set Trigger Source sts 1|2 OK 1: CC1 port input
Get Trigger Source gts 112 2: External input
Set Trigger Polarity stp O1 OK 0: Active low
Get Trigger Polarity gtp 01 1: Active high
Set Exposure Source ses 01 OK 0: Program Exposure (by camera)
Get Exposure Source ges o 1: Pulse Width (by external trigger input)
Set Exposure Time set n OK n: Exposure Time in s
Get Exposure Time get n (Setting range: 10 ~ 7,000,000 ps)
Set Analog Gain sag n OK n: Analog Gain parameter
Get Analog Gain gag n (Setting range: 0 ~ 63)
Set Analog Offset sao n OK n: Analog Offset parameter
Get Analog Offset gao n (Setting range: 0 ~ 63)
Set Test Image sti O[1]2]3 | OK 0: Off
Get Test Image gti 0|112|3 1, 2: Fixed pattern image
3: Moving pattern image
Set Data Bit sdb 8|10 OK 8: 8 bit output
Get Data Bit gdb 8|10 10: 10 bit output
Set Strobe Offset S§SO n OK n: Strobe Offset time in microseconds
Get Strobe Offset gso n (Setting range: 0 ~ 100,000 vps,
Only available on VC-25MC)
Set Strobe Polarity ssp 01 OK 0: Active low
Get Strobe Polarity gsp o1 1: Active high

Table 9.1 Command List #1
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Command Syntax Return Value Description
Generate Offset Calibration Data | god OK Generate offset calibration data to the
volatile memory
Save Offset Calibration Data sod OK Save offset calibration data to the flash
memory
Load Offset-Calibration Data lod OK Load offset calibration data from the flash
memory (Calibration data is loaded
automatically at the start-up status)
Set Defect Correction sdc 0|1 OK 0: Off
Get Defect Correction gdc o 1: Active of Defect Correction
0: 2 Tap output
Set Camera-Link Mode scl 0]1]2|3 | OK 1: 4 Tap output
Get Camera-Link Mode gcl 0]112|3 2: 8 Tap output
3: 10 Tap output
Set Binning Factor sbf 1|2 OK 1: binning off
Get Binning Factor gbf 112 2: 2 by 2 binning
Table 9.2 Command List #2
Command Syntax Return Value Description
Save Config To sct 1)2 OK 1: Save to User 1 Setting
2: Save to User 2 Setting
Load Config From Icf 0|1]2 OK 0: Load from Factory Setting
1: Load from User 1 Setting
2: Load from User 2 Setting
Set Config Initialization sci 0]1|2 OK 0: Load from Factory Setting when initializing
Get Config Initialization gci o112 1: Load from User 1 Setting when initializing
2: Load from User 2 Setting when initializing
Get Model Name gmn String Display Model Name
Get MCU Version gmv String Display MCU version
Get FPGA Version gfv String Display FPGA version
Get Serial Number gsh piece String Display Serial Number
Get Current Temperature gct String Display Temperature value
Table 9.3 Command List #3
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Command

Syntax

Return Value

Description

Set Region Select srs n OK

n: Region number (0 - 31)
Get Region Select grs n
Set Region Mode (current region) | src 0|1 OK 0: Region Off
Get Region Mode (current region) | grc on 1: Region On
Set Offset X SOX n OK

n: X axis offset
Get Offset X gox n
Set Offset Y (current region) soy n OK

n: Y axis offset
Get Offset Y (current region) goy n
Set Width siw n OK

n: Width value
Get Width giw n
Set Height (current region) sih n OK

n: Height value
Get Height (current region) gih n
Update Multi-ROI ast OK Update multi-ROI settings
Set RGB Gain srg rlglb f OK
Get RGB Gain grg riglb f f: Gain parameter
Auto generation RGB Gain arg OK

Table 9.4 Command List #4 (VC-12MC/VC-25MC Only)

Command Syntax ‘ Return Value Description
Set FFC Target Level sftl n OK n: Target Level (0 ~ 255 DN)
Get FFC Target Level gftl n (Only available on VC-25MC-30 D)
Generate Flat Field Data gfd OK Operate Flat Field generator
Save Flat Field Data sfd OK Save Flat Field data
Load Flat Field Data Ifd OK Load Flat Field data
Set Flat Field Correction sfc 01 OK 0: Off
Get Flat Field Correction gfc o1 1: Active of Flat Field Correction
n: Flat Field data index number
Setting range:
Set Flat-Field Selector sfs n OK
* VC-12MC/VC-25MC: 0~3
Get Flat-Field Selector gfs n
* VC-25MC-30 D: 0~9
(Only available on VC-12MC/VC-25MC)

Table 9.5 Command List #5 (Flat Field Correction)
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Command Return Value Description
Set HDR Mode shm 0|1 OK 0: Normal mode
Get HDR Mode ghm on 1: High Dynamic Range mode

n: Dynamic range in dB
(Setting range: 0 ~ 40 dB)
Table 9.6 Command List #6 (High Dynamic Range)

Set High Dynamic range shd n OK

Command Syntax Return Value ‘ Description
Set Sequencer Mode sssm Q|1 OK 0: Sequencer Mode Off
Get Sequencer Mode gssm on 1: Sequencer Mode On
Set Sequencer Set Count §SSC N OK n: The number of Sequencer Set to
Get Sequencer Set Count gssc n apply (1 ~ 30)
Set Sequencer Set Selector ssss n m | OK n: Index of Sequencer Set (0 ~ 29)
Get Sequencer Set Selector gsss n m m: Index of FFC data (0 ~ 9)
Reset Sequencer rssc OK Returns to Sequencer Set 0.
Reset Flat Field Data rfd OK Clears the selected FFC data.

Table 9.7 Command List #7 (Sequencer — VC-25MC-30 D Only)
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10 Configurator GUI

Configurator, a sample application, is provided to control VC Series camera. Configurator provides easy-to-use

Graphic User Interface (GUI) for the user while using the commands mentioned previous chapters.

10.1 Camera Scan

When you execute the program while the camera is turned on, Camera Scan window appears as shown in the
figure below. At this time, the program checks serial port of computer and DLL provided by Camera Link to scan
whether the camera is connected. If there is a camera connected, it displays model name on the screen. If the
camera is not properly displayed on the screen, check the connection of cable with power of camera and press
the refresh button. When you double-click model name displayed on the screen, Configurator is executed and

displays current setting value of camera connected.

Camera Scan =]
vieworks
INDUSTRIAL CAMERA
Port Camera
COM3 VC-25MC-M30
COomM1 Not found

Solics XCL.0 Port0

[ ok H Close |

Figure 10.1 Configurator Loading Window
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10.2 Menu

10.2.1 File
© Vieworks - VC-25MC-M30 =x EoR==
Start-Up  Tool About
Load Setting 4 From File
i 4
Save Setting From Factory Space
Defect Pixel 4 From Userl Space
System Upgrade [ From User2 Space
Exit
R ™
) 23 5120 (H) % 5120 (V)
Test Image
C) None
0) Test #1
) Test#2 i
(@) Test#3 -
Camera Link Output Data Bit Dark Image Correction
2 Tap (Base] @ 8Bt () 10 Bit
4 Tap (Medium] Image Processing
(@) 8 Tap (Fully =
) 10 Tap (Full) [ Defect Corr. N
VC-25MC-M30 33T [(£]v22102
Figure 10.2 File Menu
¢ Load Setting: Loads the camera setting value from the camera memory (Factory, User1,
User2) or user computer (From File).
e Save Setting: Saves the camera setting values to the camera memory (User1 or User2) or
user computer (To File).
¢ Defect Pixel: Downloads defect information to the camera (Download to Camera) or uploads
defect information saved in the camera to user computer (Upload to PC).
¢ System Upgrade: Upgrades MCU program or FPGA logic.
Exit: Exits Configurator.
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10.2.2 Start-Up

You can select the camera setting values to load when the camera is turned on.

Factory Setting:
User1 Setting:
User2 Setting:

© Vieworks - VC-25MC-M30 =n R ===
File | Start-Up | Tool About
| VIEW Factory Setting
Mo{ v Userl Setting T, AN
@ User 2 Setting
~) HOT
0
Binning
@ 1x1 :
) 22 5120 (H) x 5120 (V)
Test Image
) None
() Test #1
= 5119
) Test #2
(@) Test#3 -
Camera Link Output Drata Bit Dark Image Correction
2 Tap (Base) @ &Bit () 10 Bit
4 Tap (Medium) Image Processing =Enerate Lala
(@ 8 Tap (Full) ———
- Save Data
(7110 Tap (Full} 7| Defect Corr.
VC-25MC-M30 33t [€)vaai0z

Figure 10.3 Start-Up Menu

Loads the camera setting values from Factory Space.

Loads the camera setting values from User1 Space.

Loads the camera setting values from User2 Space.
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10.2.3 Tool
@ Vieworks - VC-25MC-M30 [ |2 23]
File Start-Up About
WIEW | MODE/E] Refresh
Mod co
. oee Terminal ' S118
@ Momal i i
_ Color Calibration
) RO
Factory Setting
Binning High Speed
@ 11 -
& 22 5120 (H) x 5120 (V)
Test Image
) None
) Test #1
) Test#2 it
(@) Test#3 .
Camera Link Output Data Bit Dark Image Correction
2 Tap (Base) @ aBit () 10 Bit
4 Tap (Medium} Image Processing ErrEERlLE
(@) 8 Tap (Fully =
- —=ave Lala
) 10 Tap (Full) [| pefect Corr.
VC-25MC-M30 33t [£]vz22102
Figure 10.4 Tool Menu
* Refresh: Loads and displays the current camera setting values on Configurator.
e Terminal: Displays user commands in Terminal window under GUI.

To hide Terminal window, uncheck Terminal by clicking again.

e Color Calibration:  Displays the Color Calibrati

on window for Bayer sensor color temperature

Calibration (VC-12MC/VC-25MC Only). When you click the Auto White Balance

button, white balance is adju

sted once and then Off.

Color Calibraiton =]
Bayer Gain
Red Gain Green Blue Gain
.. 1.00000 1.00000 1.00000
[ Color Reset l | Auto White Balance: |

Figure 10.5 Color Calibrati

on (VC-12MC/VC-25MC Only)

* Factory Setting: Not supported in the user side.

e High Speed: Not supported on VC Series.
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10.2.4 About
@ Vieworks - VC-25MC-M30
File Start-Up Tool [.Ahout
| VEW [MoDEEXP[AN  Cameralnfo
~EEE o [+]» ][ 5119
i@ MNomal
@) RO
0
Binning
@ 1x1 =
7 2x2 5120 (H) x 5120 (V)
Test Image
) None B
() Test #1 '
) Test#2 e
@) Test#3 =
Camera Link Output Drata Bit Dark Image Correction
2 Tap (Base) @ 8 Bit () 10 Bit
4 Tap (Medium) Image Processing e
@8
ap (Ful Save Data
(7110 Tap (Full} 7| Defect Corr.
VC-25MC-M30 33t [[E]vza102
About . (=
vieworks
INDUSTRIAL CAMERA
Camera Information
Camera Name : VC-25MC-M30
Serial Number : Z9-MCEABU012
FPGA Version : 00.91
MCU Version : 00.94
Copyright (2 Vieworks. 2011 All rights reserved.
Configurator Version : v2.2.10.2 -
Figure 10.6 About Menu
e Camera Info: Displays camera information (product name, serial number, version, etc).
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10.3 Tab

10.3.1 VIEW tab

VIEW tab allows you to set the camera readout mode, test image mode, data bit, channel, LUT, image

processing, etc.

@ vieworks - VC-25MC-M30 == =R
Eile Start-Up  Tool About
| VEW | MODE/EXP | ANALOG |
Mode o[« [ 511
@) Nomal
©) ROI
0
Binning
@ 1x1 .
) 22 5120 (H) % 5120 (V)
Test Image
) None
i) Test #1
) Test#2 i
@ Test#3 -
Camera Link Output Data Bit Dark Image Correction
2 Tap (Base) @ 8Bit () 10Bit
4 Tap (Medium) Image Processing e
@) 8 Tap (Full) P
() 10 Tap (Full) [| Defect Corr R
VC-25MC-M30 $333t  [(€vzz2i02
Figure 10.7 VIEW Tab
*  Mode: Selects readout mode. If ROl is selected, ROI setting area is activated

and ROI can be set by entering desired values. If Binning is selected,

x2 option button is activated (Supported only on VC-25MC).

¢ Test Image: Selects whether to apply test image and the type of test image.
e Camera Link Output: Selects Camera Link output mode.

* Data Bit: Selects width of data output.

* Image Processing: Sets Defect Correction feature On or Off.

¢ Dark Image Correction: Corrects Fixed Pattern Noise at camera dark image.

(Not supported on VC-25MC)
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Configurator provides the VIEW tab for the VC-12MC/VC-25MC models as follows.

=
File Start-Up Tool About

| vEw [mope/Ex [ anaLos [ Frc |
Mode

Binning

1x1 4096 (H) x 3072 (V)
pves

Test Image
@ Mone

i) Test #1
i) Test #2
) Test#3

Camera Link Qutput Diata Bit Dark Image Correction
(@ 2 Tap (Base) @ &Bit () 10 Bit
(2 4 Tap (Medium) Image Processing
(Z) 8 Tap (Full) Flat Field Corr.
() 10 Tap (Full) Defect Cor.

Generate Data

Save Data

>> set10 OK (109 ms) 69T [Elv2z212

Figure 10.8 VIEW tab for VC-12MC

¢ Full: Disables the Multi-ROI feature and set to its full resolution.
* ROI: Displays the Setting Multi-ROI window for setting Multi-ROI.
Multi-ROIl on VC-12MC Multi-ROIl on VC-25MC
Mum Offset X Offset Y Width Height Status

0 0 4096 3072 ON |
| o | o | e | w2 | oFlg
| o [ o | s | s | orlM
| o [ o [ s [ s72 | OFF]
| o [ o [ a4 [ s72 | OFF]
| o | o [ ass [ z:om | oF]
| o [ o [ a4 [ sm | OFF]
| o [ o [ a4 [ s72 | OFF]
| o [ o [ s [ s72 | OFF]
| o [ o [ a4 [ 372 | OF]
| o | o | 496 [ 72 [ ol

3

4 LI

Figure 10.9 Setting Multi-ROI

¢ Flat Field Correction: Sets the Flat Field Correction feature On or Off.
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10.3.2 MODE/EXP Tap

MODE/EXP tab allows you to select trigger mode, exposure time and strobe.

e Trigger Mode:

e Exposure:
* Source:

* Polarity:

e Exposure Time:

e  Strobe Type:

e  Strobe Polarity:

@ Vieworks - VC-25MC-M30 o=
File Start-Up Tool About
WODE/EXP | ANALOG
Trigger Mode
@ Free-Run
_ External Sync
Exposure Source Polarity
(@ Pulse Width @ CC1 port Active Low
Program External Port (@ Active High
Exposure Time
; 10 =
10 us 1 ms 100 ms Ts 10 us
Strobe Type Strobe Polarity
Marrow Output _) Active Low
Wide Output @ Active High
VC-25MC-M30 B3t [(Eve2i02
Figure 10.10 MODE/EXP Tab

Selects trigger mode. Once a mode has been selected, related selections will be

activated.
Selects exposure source.

Selects trigger source.

Selects polarity of trigger input.

Sets exposure time when trigger mode is set with Free-Run mode or when

Exposure is set with program.

Sets strobe type.

Sets the polarity of strobe output signal.
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10.3.3 ANALOG Tab
ANALOG tab allows you to set gain and offset settings of the image.

@ Vieworks - VC-25MC-M30 o=
File Start-Up Tool About
Video Gain
0 2 [=
0 3 63
8 12 [dB]
Video Offset
=, s
0 31 63
VC-25MC-M30 B3t [(Eve2i02

Figure 10.11 ANALOG Tab

* Video Gain: Sets a gain value.

e Video Offset: Sets an offset value.
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10.3.4 FFC Tab

Configurator provides the FFC tab for the VC-2MC-340, VC-4MC-180, VC-12MC-65, VC-25MC-30 and
VC-25MC-30 D models as follows.

o FFC Data:

*  Flash Memory:

e FFC Data Download / Upload:

o FFC Offset Level:

(o] s

@ Vieworks - VC-12MC-CB5
File Start-Up Tool About
| viEw | MODE/EXP | ANALOG | FFC |

FFC Data Flazh Memory

Number of acquisition frame
Load from Flash

1 2 4 8 16

Save to Flash

Generate

FFC Data Downlead ! Upload

Download to camera l [ Upload to PC
FFC Offzet Level
-1
0 2047 4095
VC-12MC-C65 soac [{€)v2z2102

Figure 10.12 FFC Tab

Generates the Flat Field Correction data to be used for correction.

You can set only one frame for correction.

Saves (Save to Flash) the generated FFC data to Flash in order to

reuse in the future or loads (Load From Flash) the saved FFC data.

Downloads (Download to camera) FFC data from the user computer

or uploads (Upload to PC) FFC data to the user computer.

Sets the offset value of the image after applying the Flat Field

Correction.
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11 Troubleshooting

* If noimage is displayed on the screen,
= Ensure that all the cable connections are secure.
s Ensure that the power supply is properly connected.

s Ensure that trigger signal is applied correctly when you use external trigger mode.

¢ Ifimages are not clear,
s Ensure the camera lens or glass is clean.

s Check that the lens aperture is adjusted properly.

* Ifimages are dark,
s Ensure that your camera lens is not blocked.

s Check that exposure time is set properly.

* If you identify abnormal operation or overheating sign,
= Ensure that the power supply is properly connected.

= Stop using the camera when you notice smoke or abnormal overheating.

* If the trigger mode is not working correctly,
= Ensure that CC1 setting on the grabber board is configured correctly when you use CC1 trigger mode.

o Ensure that cable connections are secure when you use external trigger mode.

* If you identify the difference between left and right image,
s Check whether left and right gain settings are different.

s Check whether left and right offset settings are different.

* If there is a communication failure between the camera and PC,
o Ensure that the camera link cable is connected properly.

= Ensure that serial communication settings are configured properly on both PC and frame grabber.

Page 81 of 89 RA14-11A-010



VIEWOrkKks

VC Camera Link series

Appendix A Defective Pixel Map Download

1. Create the Defective Pixel Map data in Microsoft Excel format as shown in the left picture below and save

as a CSV file (*.csv). The picture in the right shows the created Excel file opened in Notepad. The following

rules need to be applied when creating the file.

= Lines beginning with " or ‘—' are treated as notes.

= You must enter the horizontal value first and then the vertical value for coordinate of each defect pixel.

= Coordinate values for each pixel can be placed in any order.

E Microsoft Excel - defectDats. ¢

HA] MRS BHEE BN 2R

BTN R 1R W NmeA - N

i sy 4.4 FR
Le2 vk

o R g

| cormienl line

|

|

f

A B

2 |=— comment line
S| — H Y
4 | 2011 3
5 | 3 7
6 | 52 3
7 | [SEEE] B
Q 788 10
9 | 1112 10
110 1713 12
608 13

pral=le

DR Ry MEE) M0y =22
:comment line,
—— comment line,
-— H, ¥

2811,3

178.,7

52.8

699,8

268,18

1112 ,18

1712 ,12

608,16

2. Select File > Defect Pixel > Download to Camera on Configurator.

@ Vieworks - VC-25MC-M30

Start-Up  Tool About

Load Setting
Save Setting

Defect Pixel
Systern Upgrade

Exit

[E=8(E=R (>
3
Y o[ ANIERE
3 Download to Camera
3
Upload to PC

T T ™

Test Image
7} None

) Test#1

") Test #2

@ Test#3

5119

Camera Link Qutput
2 Tap (Base)
4 Tap (Medium})
(@) 8 Tap (Full)
() 10 Tap (Full)

5120 (H) x 5120 (V)

u

Data Bit Dark Image Correction

@ 3 Bit () 10 Bit

Image Processing Generate Data
Save Data

|:| Defect Corr.

WC-25MC-M30

B3t [([E)wve2i02
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3. Search and select the created file and click Open.

Recent Places

(@ Open

Lookin: |, Upgrade

I Name

- 0 @

Date modified Type

S i defect

7/30/201310:21 AM  Microsoft

Libraries

Q*A\;

Computer

~ < | 1

File name: defect

Flesoftype:  [CSVfiles (csv)

4. Configurator starts downloading defective pixel map data to the camera and downloading status is

displayed at the bottom of the window.

ATEE o[«

© vieworks - VC-25MC-M30 =x =R
File Start-Up Tool About
| vEW | moDe/ExP [ AnaLos|

|| 5118

@) Nomal

) RO

Binning
@ 1x1
22
Test Image

(") None

.

i) Test #1

£
=
=
1<)

i) Test#2

5120 (H) x 5120 (V)

@
@ Test#3 Full

Camera Link Output Cata Bit

2 Tap (Base) @ & Bit () 10 Bit
4 Tap (Medium}) Image Procezsing
(@) & Tap (Full)
(2110 Tap (Full) [7] Defect Corr.

Dark Image Correction

Generate Data

Save Data

- ™ 50 %

V22102

Page 83 of 89

RA14-11A-010



VIEWOrkKks

VC Camera Link series

sure not to disconnect the power cord.

the window.

@ Vieworks - VC-25MC-M30
File Start-Up Tool About
| vEW |[uone/Exe [ anaLos|

Mode

@) Nomal
@ ROI

Binning

@ 1x1

) 22 5120 (H) x 5120 (V)

Test Image
) None

) Test #1

£
=
=
1<)

() Test #2

@ Test #3 -

u

Camera Link Output Cata Bit

2 Tap (Base) @ 8 Bit () 10 Bit
4 Tap (Medium} Image Procezsing
(@) 8 Tap (Full)
(7110 Tap (Fully [ pefect Corr.

Dark Image Correction

(%)
=
i
[=)
=]
(1

Downlead completed

$3t  [(Elvazi0z

Once the download has been completed, the saving process will begin. During the saving process, make

Once all the processes have been completed, Download completed message will appear at the bottom of
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Appendix B Field Upgrade

B.1 MCU

1. Select File > System Upgrade > MCU Upgrade on Configurator.

2.

@ vieworks - VC-25MC-M30

Start-Up  Teol About

Load Setting
Save Setting

Defect Pixel
System Upgrade

Exit

3

3

4

=N e~

o[

x| 5118

MCU Upgrade
FPGA Upgrade

L (i
(@) e]

Test Image

) Test#2 5119
@ Test#3 Full
Camera Link Output Data Bit

None ’7
Test #1 .

2 Tap (Base)
4 Tap (Medium})

(@) & Tap (Fully

10 Tap (Full}

5120 (H) x 5120 (V)

@ 8 Bit () 10 Bit

Image Processing

|:| Defect Corr.

Dark Image Correction

Generate Data

Save Data

Download completed

33t [E)vazai02

Search and select the provided MCU upgrade file, and then click Open.

@ Open ==
Lookin: || Upgrade - & 5 Al Bk
= Name . Date modified Type
&~ {1TVC2 751 00 94 srec 173173013 3:36 PM _ SREC File

Recent Places

Desktop

=
Libraries

Ay

L

Computer

Network

< |

Ll

File name:

VC2_25M_00_94

Files of type:

[ File{" srec)

| 3
¢
Cancel

[] Open as read-only

Page 85 of 89

RA14-11A-010



VIBEWOrkKs VC Camera Link series

3. Configurator starts downloading MCU upgrade file to the camera and downloading status is displayed at the
bottom of the window. This process may require several minutes to complete. If you want to cancel the

upgrade process, click Cancel.

© Vieworks - VC-25MC-M30 =N =
File Start-Up Tool About
VEW | MODE/EXP | ANALOG
LFEE o |[<] ][ 5118
@ Momal
7 ROI
0
Binning
@ 1x1
) 9x7 5120 (H) x 5120 (V)
Test Image
) None
) Test #1
= 5119
() Test #2
@) Test#3 -
Camera Link Qutput Data Bit Dark Image Correction
2 Tap (Base) @) 8Bit () 10Bit
4 Tap (Medium) Image Processing Sarselas
(@) & Tap (Fully S
- Save Data
) 10 Tap (Fully [| Defect Corr.
- ™ | 38% v2.210.2

4. Once the download has been completed, the saving process will begin. During the saving process, the

camera cannot be restored if a power failure occurs. Make sure that the power connection is secure.

@ Vieworks - VC-25MC-M30 o=
Eile Start-Up Tool About
VEW | MODE/EXP | ANALOG

LTEE o[+ ][ 5119
@ Momal

) ROI

0
Binning
@ 1x1
o 2o 5120 (H) % 5120 (V)

Test Image

) None

) Test #1

@) Test #2 5119

@ Test#3 -

Camera Link Output Data Bit Dark Image Correction

2 Tap (Base) @ 8Bit ()10 Bit
4 Tap (Medium) Image Processing SREEEIEE

(@ & Tap (Fully e

. Save Data

) 10 Tap (Full) [| Defect Corr.

Download completed $33C [[E)vazioz
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5. Once all the processes have been completed, turn the power off and turn it back on again. Select Tool >

Terminal and enter the ‘gmv' command to confirm the version. Or, select About > Camera Info to confirm
the MCU version.

About ..
vieworks

INDUSTRIAL CAMERA

Camera Information

Camera Name : VC-25MC-M30
Serial Number : Z9-MCEABU012
FPGA Version : 00.91

MCU Version : 00.94

Copyright (8} Vieworks. 2011 All rights reserved.

Configurator Version : V2.2.10.2
‘ oK
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B.2 FPGA

1. Select File > System Upgrade > FPGA Upgrade on Configurator.

-

=]l =]

@ Vieworks - VC-25MC-M30
[ File | Start-Up Tool About
Load Setting 4

Save Setting L Y e

Defect Pixel 4

x| 5118

System Upgrade 4 MCU Upgrade

FPGA Upgrade

Exit
T T
© 22 5120 (H) x 5120 (V)

Test Image
") None .

™) Test #1

£
=
=
1<)

(7) Test #2
© Test#3

Full

Camera Link Output Data Bit Dark Image Correction

2 Tap (Base) @ 2 Bit () 10 Bit

4 Tap (Medium} Image Processing Generate Data
@) & Tap (Full
= A Save Data
(2110 Tap (Full) [7] Defect corr

33t [[E]vz2z102

Download completed

2. Search and select the provided FPGA upgrade file and click Open.

) Open
Lookin: |, Upgrade > @ 7 e E
B Name : Date modified Type
b ¢ VC-25M30 V0O 91.bin 11/1/20124:48 PM  BIN File
Recent Places
Desktop
LiBraries
L
Computer
o, < | i}
“
File name: VC-25M30_V00_91 v
Network
Files of type: [Binary File{" bin) '] [ Cancel

[7]Open as read-only

3. The subsequent processes are identical to those of MCU upgrade.
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